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Disclaimer 
Great care has been taken in compiling the texts and images. Nevertheless, the possibility of errors 
cannot be completely eliminated. The handbook purely provides a product description and is not to be 
understood as being of warranted quality under law. The publisher and authors can accept neither legal 
responsibility nor any liability for incorrect information and its consequences. No responsibility is 
assumed for the information contained in this handbook. 

The software described in this handbook is supplied on the basis of the license agreement which you 
accept on installing the program. 

No liability claims may be derived from this.  

Making copies of the handbook is prohibited. 

 

Copyright and Trademarks 
Windows Vista®, Windows XP®, and Windows 7® are registered trademarks of Microsoft Corp. All 
program names and designations used in this handbook may also be registered trademarks of their 
respective manufacturers and may not be used commercially or in any other way.Errors excepted.  

Berlin, November 2011  

COPYRIGHT © 1993-2011 Dr.-Ing. Gerhard Valentin 

 

Vertrieb: Dr. Valentin EnergieSoftware GmbH 
Internet: http://www.valentin.de 
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User Manual GeoT*SOL basic   

page 3 / 50 Dr. Valentin EnergieSoftware GmbH 

Table of Contents 

1 GeoT*SOL basic program concept ............................................................................. 5 
1.1 GeoT*SOL basic features ............................................................................................... 6 

2 Software administration ........................................................................................... 7 
2.1 Hardware and Software Requirements ............................................................................ 7 
2.2 Installation.................................................................................................................... 7 
2.3 Activating the Program .................................................................................................. 8 
2.4 Licencing Terms: How many times can the program be installed?................................... 10 
2.5 Maintenance agreement .............................................................................................. 10 
2.6 Internet Update ............................................................................................................ 11 

3 Heating with Geothermal Energy .............................................................................. 12 

4 Designing Heat Pump Systems – Quick-Start ............................................................ 13 

5 Menus .................................................................................................................... 14 
5.1 File menu .................................................................................................................... 14 
5.2 Databases menu .......................................................................................................... 14 
5.3 Options menu .............................................................................................................. 14 

5.3.1 User data / contact data ........................................................................................ 14 
5.3.2 Project report ........................................................................................................ 14 
5.3.3 Internet update ..................................................................................................... 15 
5.3.4 Directories ............................................................................................................ 15 

5.4 Language menu ........................................................................................................... 15 
5.5 Help menu ................................................................................................................... 15 

5.5.1 Updates ................................................................................................................ 15 
5.5.2 Other internet services .......................................................................................... 15 
5.5.3 Info = contact data, licensing agreement, software components, registration .......... 16 

5.6 Errors and warnings ......................................................................................................17 

6 Welcome ................................................................................................................ 18 

7 Project data ............................................................................................................ 19 
7.1 MeteoSyn .................................................................................................................... 20 
7.2 MeteoSyn, select climate data from a location table ...................................................... 21 
7.3 Options ....................................................................................................................... 22 

7.3.1 File Import and Database Update ........................................................................... 22 

8 System Selection ................................................................................................... 23 
8.1 Heat Pump Systems (HPS) in GeoT*SOL basic ............................................................... 24 

9 Space Heating ....................................................................................................... 26 

10 Domestic hot water ................................................................................................. 27 

11 Heat pump ............................................................................................................. 29 
11.1 Select Heat Pump ........................................................................................................ 30 
11.2 Customized Heat Pumps .............................................................................................. 32 



  User Manual GeoT*SOL basic 

Dr. Valentin EnergieSoftware GmbH page 4 / 50 

12 Heat source ........................................................................................................... 34 
12.1 Select a heat source .................................................................................................... 34 
12.2 Sizing of an Air-Water Heat Pump System ..................................................................... 34 
12.3 Designing a geothermal probe ..................................................................................... 34 

12.3.1 Calculating the length of the geothermal probe ...................................................... 36 
12.3.2 Sizing the total drilling length ............................................................................... 36 
12.3.3 Sizing with maximum drilling depth ....................................................................... 37 

13 Tank ..................................................................................................................... 38 

14 Solar loop ............................................................................................................. 39 

15 Results .................................................................................................................. 40 
15.1 Project report .............................................................................................................. 41 
15.2 Financial analysis ........................................................................................................ 42 

16 Glossary ................................................................................................................ 44 

17 Index .................................................................................................................... 49 

 



1 GeoT*SOL basic program concept  User Manual GeoT*SOL basic 

page 5 / 50 Dr. Valentin EnergieSoftware GmbH 

1 GeoT*SOL basic program concept 
GeoT*SOL basic is a professional tool for planning and designing heat pump systems. You can select 
various system types and components, calculate energies and costs in order to achieve the best possible 
seasonal performance factor. 

 
• GeoT*SOL basic simulates heat pump systems, as required in combination with solar thermal 

collectors. 
• All heat pump systems can be simulated with either air/water or brine/water heat pumps. 
• The required depth of the geothermal probe(s) is calculated. 
• The seasonal performance factor is calculated with the help of the dynamic simulation to the 

minute for the entire heat pump system over a year. 
• The seasonal performance factor for BAFA funding is simulating in accordance with EN 15316-4-

2 and, for comparison, calculated in accordance with VDI guideline 4650. 
• Financial analysis: the heating price is calculated as an average over the expected lifetime. 

  

GeoT*SOL basic features simple system navigation and a clear program structure. Your work is made 
easier by: 

• simple project management, 
• a large number of climate data records, 
• quick and easy system parameter setting, 
• up-to-date databases (collectors, heat pumps) and 
• clear project reports. 
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1.1 GeoT*SOL basic features 
  

 
Start-up screen 

 
Project data management 

 
MeteoSyn: climate data and location database, 2,000 locations around the world 

 
Various heat pump systems (HPS) 

 
HPS with heating support 

 
HPS for DHW supply 

 
Heat pump database with 60 different heat pumps from leading manufacturers 

 
Simulation adapted for both heat source types: ground or air 

 
Characteristic values for DHW and heating buffer tank are configurable 

 

HPS with solar collectors, database from T*SOL; characteristic values for collector, 
orientation, piping 

 

Forecast of seasonal performance factor and energy generated with simulation to the 
minute 

 

Financial analysis: calculation of the heating price, profitability of your heat pump 
system 

 
Configurable project reports as a print-out or file (.pdf, .rtf and others) 
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2 Software administration 

2.1 Hardware and Software Requirements 
Processor: 1,5 GHz Pentium PC 

RAM: 512 MB 

Free hard disk space: 400 MB. Each additional climate data file requires 5 MB. 

Color monitor: VGA, min. 1024x768, 16 bit color depth 

Operating system: Windows XP ServicePack 3, Windows Vista or Windows 7 

Software: .Net framework version 3.5  ServicePack 1 (comes with Windows 7, download if needed). 

Mouse 

A printer with graphics capability 

In order to run GeoT*SOL basic, you must have full access (administrator rights) to the GeoT*SOL basic 
installation directory. 

GeoT*SOL basic adopts the formats for currency, numbers, time and date set in the country settings of 
Windows' control panel. These formats also appear on print-outs. It is important for the operation of the 
program that separators for thousands and decimals are different. 

Recommended configuration: 

Internet connection for updates and climate data 

You should set your monitor to display Small Fonts via the Windows control panel. 

2.2 Installation 

 

Image 2.2.1: Installation set-up 
assistant 

To install the program, please click on the installation file geotsol_basic.exe. You will be guided through 
the installation. 
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If installing from CD, place the CD into your computer's CD drive. If you have not deactivated the CD drive 
autorun function, the installation program will start automatically. Otherwise, open your operating 
system's file manager or Explorer and double-click the file geotsol_basic.exe in the CD drive. 

In order to install the program, you must be logged on with administrator rights. 

To run the program, you must have read and write rights to the GeoT*SOL basic program directory. (e.g. 
C:\Program Files\Valentin EnergieSoftware\GeoTSOL). 

All installation paths have English descriptions. 

The programme icon appears in the Windows Start Menu and on the desktop after installation. 

The single-user version of GeoT*SOL basic® can only be installed locally. However, because it is possible to 
save the database and project files under any path, and these can be set as standard paths in the 
program, parts of the program can be moved to different hard drives.  

2.3 Activating the Program 

 

Image 2.2.2: Activation assistant 

After installing and opening the program, you will be asked whether you wish to start the program as a 
demo version or register the full product. This prompt appears every time you start until the program has 
been activated. 

Activation of the program is carried out by entering an activation code. This code is provided during the 
activation process. 

è Requirement: Serial number 
The serial number is made up of a combination of 37 digits and letters, which you will have to enter 
without any spaces in between, but including the special characters (hyphens). You will find the 
serial number either on the CD case or on the invoice. Alternatively, if you made your purchase 
online, you will have been notified by e-mail. 

è How to activate the program:  
Proceed through the following registration steps: 

1. Install the program. 

2. Start the program. 

3. Navigate to the menu Help > Info > Registration, and click on Change Registration 

4. Click Continue 

5. Enter the serial number. 
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If you have purchased the program, you already have a serial number. It can either be found on your 
invoice or was sent to you by e-mail. The serial number has the following format:  
12345-123A-123-ABCD-1-ABCD-AB-ABCD-ABC. Enter the serial number without spaces. The program 
will then allocate a program ID, consisting of the serial number and a code for your PC. 

You don't have a serial number? 

If you have installed the program from a demo CD or downloaded it from the internet, you need to 
purchase a full version of the program to obtain a serial number. 

Send us the order form, which can be printed within the program under Info > Registration or 
purchase the program direct from our website. 

You've purchased the programm and can't find your serial number? 

No problem. Just send us a copy of your invoice for the program with your contact details and we will 
resend you your serial number. 

6. The program ID will be created automatically. 

7. Request activation code online or by telephone: 

 
Please send us the serial number and program ID so we can provide you with an activation code. The 
activation code can be obtained in a range of ways: 

Request activation code online 
This method requires an internet connection. 

Click the Online button. A form is displayed. Enter the required data for activation. The fields marked 
* must be filled out. 

Complete the form and send it straight off, our e-mail address is already filled in. After sending, your 
activation code will be sent to the e-mail address given in around 20 minutes. 

Request activation code by fax 
Click the Fax button. A form is displayed for you to fill in and print out. After completing the form, 
send it to fax number +49 (0)30 588 439 11. 

You will then receive the activation code by e-mail or fax within one day. You can enter any e-mail 
address where the code should be sent to.  
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8. Enter activation code 

 
You now need to enter the activation code in the relevant field in the registration window manually 
or by copying and confirm with OK. 

Registration and activation are now complete. You will receive a message that registration has been 
completed and the program is now fully functional. 

2.4 Licencing Terms: How many times can the program be installed?  
The number of permissible installations corresponds to the number of licenses you have purchased. If, 
for example, you have purchased a single-user licence, you may install the program on one workstation.  

In addition, you can activate the program on a second computer, e.g. a laptop. However, this is only 
possible on the condition that the two installations are not used simultaneously. 

If you need to reactivate the software because you have modified your hardware and therefore 
reinstalled the program, you can submit a reactivation request by using a pre-prepared form. 

2.5 Maintenance agreement 
To make sure that you always work with the latest version of our programs and have the latest 
component data available, we recommend that you use our Software Maintenance Agreement 

The software maintenance covers: 

• The electronic delivery of updates, i.e. program changes within a program level of the software 
program to a higher version of the program, where delivery is made by activation: the Provider 
makes the updates available in a network and notifies the customer of the serial number 
required for activation.  

• The access to new component data via internet, i.e. updated databanks for the software program 
(e.g. collector or tank data). 

• Responding to general questions regarding delivery, serial numbers and activation of the 
software program/s and updates, as well as the ability to access component data. 
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2.6 Internet Update 
Menu Options > Internet update 

 
Bild 2.6.1: Internet update setting 

è Prerequisites: 
Formal prerequisite: Software maintenance agreement 

Technical prerequisite: Active internet connection 

è See also: 
Chapter 5.3.3 Internet update 
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3 Heating with Geothermal Energy 
The objective of a heat pump is to heat a building. For this purpose, heat is extracted from the ground, 
the air or the ground water. The heat pump requires electricity which, for example, can be generated by a 
solar installation. 

The natural environment provides a range of heat sources from which a heat pump can generate heat. 

Brine-water heat pumps 
Heat pumps with geothermal probes extract heat from deep ground, i.e. a vertical borehole with minimal 
space requirements into the earth is necessary. In Germany, borehole depths of up to 99 meters are 
allowed without special approval. From 100 m borehole depth, a license under mining law is required. 
One or more probes are used depending on the heating requirement. 

Air-water heat pumps 
An air-water heat pump extracts heat from the surrounding air and delivers it to the heating, which is 
operated with water. 



4 Designing Heat Pump Systems – Quick-Start  User Manual GeoT*SOL basic 

page 13 / 50 Dr. Valentin EnergieSoftware GmbH 

4 Designing Heat Pump Systems – Quick-Start 

 
The sequence of symbols in the toolbar from left to right corresponds to the sequence in which a heat 
pump is planned. You can still, however, toggle between the dialogs as you wish. 

Error messages, warnings, and tips are shown on the lower bar. 

è  Proceed through each dialog from left to right   and enter your system data. 

1.  Enter the project and location data. 

2.  Select a system type. 

3. Enter all the required characteristic values ( , , , , , ) for your system. 

4. ,  The last two dialogs show you the technical and financial results of a full-year simulation. 
There, you can create project reports. 
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5   Menus 

5.1 File menu 
The files relating to the heat pump systems are managed in projects.  
You can find typical functions in the File menu: 

New project, Open project, 
Save project, Save project as..., 
Open recent projects, 
Exit 

The default directory for projects is 

C:\Users\<user name>\Documents\ValentinEnergieSoftware\GeoT*SOL basic 1.0\Projects\ 

è See also: chapter 5.3.4 Directories 

5.2 Databases menu 
GeoT*SOL basic includes current heat pump and collector databases which can be kept up-to-date using 
the internet database update. 

The collector database contains all the solar collectors also included in T*SOL ®. 

The heat pump database contains brine/water and air-water heat pumps. 

5.3 Options menu 

5.3.1 User data / contact data 
Menu Options > User data 

Here, enter your personal contact details (name, telephone number and e-mail address of the contact 
person) for your customers. The data are displayed in the project report. 

You can also incorporate your company logo. 

è See also: chapter Fehler! Verweisquelle konnte nicht gefunden werden. Fehler! Verweisquelle 
konnte nicht gefunden werden. 

5.3.2 Project report 
Menu Options > Project report 

You can compile the project report from the following elements: 

 Title page with/without  
  Background image 

 Results of annual simulation with/without 
  System diagram 

 Settings 

 System components 

 Financial analysis 

 VDI 4650 
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 Charts 

5.3.3 Internet update 
Menu Options > Update configuration 

Select whether the program should search the internet for updates daily on starting. 

There are various extensive types of updates, e.g. program or database updates. 

Recommendation:  
Software maintenance agreement, see: http://www.valentin.de/en/sales-service/customer-
service/software-maintenance-agreement 

è How the internet update works: 
1. Technical requirements: active internet connection 

2. If an internet connection is available, the program checks for new program releases either once a 
day when starting or when you click on Check now ....  

3. If a new release is available, GeoT*SOL basic will close and the installation program will be 
downloaded to the Desktop and run from there. 

5.3.4 Directories 
Menu Options > Set directories 

The directories in which projects and project reports are saved can be selected under Options > 
Directories. When GeoT*SOL basic is installed, the following paths are set by default: 

Projects C:\Users\<user name>\Documents\ValentinEnergieSoftware\GeoT*SOL basic 1.0\Projects\ 

Project reports C:\Users\<user name>\Documents\ValentinEnergieSoftware\GeoT*SOL basic 
1.0\Projects\ 

5.4 Language menu 
GeoT*SOL basic 1.0 works in German and English (U.S.). 

5.5 Help menu 
This menu provides assistance when using GeoT*SOL basic : 

Here, you find the contents of  the GeoT*SOL basic help system. Context-sensitive help can also be 
opened within the program by pressing F1. 

The GeoT*SOL basic manual is launched as a .pdf file. For this, you need a pdf viewer or reader. These 
programs can be downloaded free of charge from the internet. 

5.5.1 Updates 
Menu Help > Check for updates 

Start the update check to find out if a new program version or, e.g., databases are available on the 
internet. 

è See also: Chapter 5.3.3 Internet update 

5.5.2 Other internet services 
These include 

• direct access to the online shop of Dr. Valentin EnergieSoftware GmbH , 

http://www.valentin.de/en/sales-service/customer
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• the order form for products by Dr. Valentin EnergieSoftware GmbH and 
• direct access to the website of Dr. Valentin EnergieSoftware GmbH. 

5.5.3 Info = contact data, licensing agreement, software components, registration 
Menu Help > Info 

Under Help > Info, you will find 

• software data, contact data and the valid licensing agreement, 
• advanced information on software components and your operating system and 
• a link to registration when you want to upgrade from the demo version to the full version. 
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5.6 Errors and warnings 

Space heating 
'The heating requirement for the month ... does not conform to the yearly profile and the climate data.' 

-> As required, correct on the settings page 

Heat pump 
'x % of the generated energy for DHW was met by the heating element.' 

-> Select a heat pump with higher power 

'x % of the generated energy for space heating was met by the heating element.' 

-> Select a heat pump with higher power 

'The power of the heat pump plus heating element (x kW) is not sufficient to meet the heating load (y 
kW).' 

-> Select a heat pump with higher power 

Ground source 
'Drilling depth must be less or equal to the maximum drilling depth.' 

-> Click the sizing button. 

'The total length of the probe, X m, is too long or too short by Y %.' 

-> Modify the parameters – within possible ranges – and then click on the sizing button until no more 
warning messages are shown. 

'The ground has cooled by x % after one year. Please check the design.' 

-> Reduce extraction power and/or increase heating element power 

Systems HP1 and HP2 
'Please select a system with heating buffer tank.' 

-> Please note: if you select another system, all dependent values will be reset. 

'The temperature difference (TD) of the radiator heating is too large to be supplied by the heat pump.' 

-> Select a different heat pump or, if possible, revert to low temperature heating 

System 
'x % of the energy required for domestic hot water ' + #13#10 + ' could not be supplied!' 

-> Increase the power of the heat pump (select different heat pump) or reduce DHW requirement (less 
meaningful solution, as cold showers are not the intention) 

'x % of the space heating requirement ' + #13#10 + ' could not be supplied!' 

-> Increase the power of the heat pump (select different heat pump) or reduce space heating 
requirement (less meaningful solution, as freezing is not the intention) 
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6 Welcome 

 
The first page contains a direct link to the quick-start guide in the help section and a link to our website. 
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7 Project data 
Symbol Project data 

  
Project and customer data appear in the project report. 

The dynamic simulation to the minute is dependent on the climate and thus the location. 

è How to proceed: 
1. Enter the required data. 

2. You can load an image of your project. 

3. Select a location and with it the corresponding climate data. 

4. Continue to the system selection. 

 

The data appear in the project and financial analysis report. 

è See also: chapter 5.3.1User data / contact data 
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7.1 MeteoSyn 
Page Project data > Climate data > Select 

The MeteoSyn module provides location-dependent climate data used in the simulation programs .  

Climate data for the U.S.A. are provided by TMY3. 

 

Image: MeteoSyn > Map 
Load climate data records 

Using the MeteoSyn climate data generator, you can select a location 

• Map: from an interactive map. 

! This only works with an internet connection! 

The geographical data of a location can be specified using the ZIP code search. 

• List: select location from a list or 
• Options: load other climate data record files in .wbv format. 

è How to select climate data: 
1. Select a country. The map shows the selected country if you have a connection to the internet. 

Otherwise see below.  

The country list contains those countries for which climate files are available. 
The location list contains the locations in these countries for which climate files are available. 

If federal states have been entered in the climate data, you will see a dropdown box for the federal 
states. 

è There are various ways of shortening the location list: 
2. Select a federal state. 

3. Enter part of the location name in the filter below the location list. 
Example: filter = "town" 
-> The list shows locations including the string "town" somewhere in their name. 

4. Enter a ZIP code. Click Start.  

The location found is marked in red , available climate data locations in the geographical vicinity 
are marked green . The location list is reduced to these nearby locations and the town, if available. 

If the ZIP code search returns no results, this is displayed in the information field. 
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è Working with the selected location 
5. Click on a green mark  to view the location name and further information. Click on the location 

name in the pop-up to select this location. This location is then listed under Selected Location 

6. Or click on a location in the location list. This location is then listed under Selected Location, moved 
to the center of the map, and highlighted on the map with a mark .  

Click on the mark to view further information such as average temperature and global radiation. 

Right-click on a location in the location list to open the corresponding folder in the file explorer. 

7. Click on OK to continue working with this location. The selected climate record is imported into the 
program. 

8. Click the Cancel button to cancel your changes. 

! The interactive map requires a connection to the internet. 

If you do not have an internet connection, MeteoSyn opens with the List page 

On the Map page, the map is grayed out and a button to test the internet connection is shown. 

Reestablish the internet connection, click on Test Internet Connection and update the website to 
regain access to the map. 

7.2 MeteoSyn, select climate data from a location table 
Page Project Data > Climate Data ( MeteoSyn)  > Location Data 

 

Image: MeteoSyn > List 

No internet connection is required for this dialog. 

The country list contains those countries for which climate files are available. 

è How to select climate data from the location table: 
1. Select a country or federal state and enter a filter for the locations.  

The locations shown in the table correspond to your entries 

The parameters displayed include ZIP code, irradiation, average temperature, latitude and 
longitude, and data source. 

2. Click on a column heading to sort the table by a specific parameter.  

You can right-click a location in the table to open the corresponding directory in the file explorer 
(this is not required for the selection here). 

3. Click on the location in the table to select it. 
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4. Exit the dialog by clicking OK.  

The selected climate record is then imported into the program. 

Click the Cancel button to cancel your changes. 

7.3 Options 
Page Project data > Climate data (MeteoSyn) > Options 

If the content of that folder has been changed outside of MeteoSyn (e.g. in the file explorer) while you 
have been working with MeteoSyn, you can rebuild the MeteoSyn database by clicking the Update 
Database button. 

The database is automatically rebuilt following a reinstallation of the MeteoSyn module. Depending on 
the number of climate data records and your computer's processing power, this may take some minutes. 

7.3.1 File Import and Database Update 

 

Image: MeteoSyn > Options 

è How to add a climate data file to a location: 
1. Click on the select .wbv file button and navigate to the desired file.  

2. Select one or several files and confirm by clicking Open. 

 These files are imported to the database and copied for all users to a specific folder , e.g. 
C:\Users\All Users\Valentin EnergieSoftware\Meteo2\_UserFiles\USA\. 

3. Exit the dialog by clicking OK. 
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8 System Selection 
Symbol Systems 

The systems which conform with your selection criteria are presented. 

è How to proceed: 

1. Select the medium of the heat source. 

Based on this, the corresponding data and characteristics values are presented on 
the heat pump and heat source pages. 

• Brine / water 
In a brine/water heat pump, the heat source system consists of brine (typically 
water with 25 % glycole) which is pumped through pipes with a brine pump, 
resulting in the brine loop. 

The pipes are placed in boreholes up to 400 m deep (vertical) as U- or coaxial 
pipes, and are then known as geothermal heat probes. 

• Air / water 
In an air/water heat pump, the heat source system consists of fans which 
generate the air stream for the vaporizer of the heat pump as well as a 
defrosting device.  

2. All systems supply hot water for heating. 
Also select: 

• Domestic hot water 

• Solar support 
  

3. The following heat pump systems (HPS) are available: 

# HPS Heating DHW 
Solar 

collector 
Tank 

01 HPS with heating x 
  

  

02 HPS with heating and DHW x x 
 

DHW tank 

03 
HPS with heating and DHW 
with solar support 

x x x DHW tank 

04 
HPS with combination tank 
and solar installation 

x x x 
Combination 
tank 

05 
HPS with heating (with 
buffer tank) and DHW 

x x 
 

Heating buffer 
tank 
+ DHW tank 

HPS = heat pump system, for details see systems; DHW = domestic hot water 

The systems can be shown in graphical form or as a list. 
Click on the desired system. 
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è Note: when changing the system, the following characteristic values are 
retained: 
• Heating 

• Domestic hot water 

• Heat pump 

• Heat source 

• Solar collector 

The following characteristic values are not kept: 

• Tank, as the tank volume is dependent on the system 

4. Proceed to the next page: Heating. 

  

8.1 Heat Pump Systems (HPS) in GeoT*SOL basic  
(HPS 01) HPS with heating 

 
Brine / water 

 

 
Air / water 

In this system, the 
heat pump directly 
loads a heating 
loop. 

(HPS 02) HPS with heating and DHW 

 
Brine / water 

 

 
Air / water 

In this system, the 
heat pump directly 
loads a domestic 
hot water loop 
with DHW tank and 
a directly loaded 
heating loop. 



8 System Selection  User Manual GeoT*SOL basic 

page 25 / 50 Dr. Valentin EnergieSoftware GmbH 

(HPS 03) HPS with heating and DHW with solar support 

 
Brine / water 

 
Air / water 

In this system, the 
heat pump directly 
loads a domestic 
hot water loop 
which is 
additionally 
loaded by solar 
power, and the 
directly loaded 
heating loop. 

(HPS 04) HPS with combination tank and solar installation 

 
Brine / water 

 
Air / water 

In this system, the 
heat pump directly 
loads a 
combination tank 
for domestic hot 
water and heating 
which is 
additionally 
loaded by solar 
power. 

(HPS 05) HPS with heating (with buffer tank) and DHW 

 
Brine / water 

 
Air / water 

In this system, the 
heat pump directly 
loads a domestic 
hot water loop and 
a heating loop, 
each with its own 
tank. 
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9 Space Heating 
Symbol Heating 

 

è How to proceed: 
1. Enter the low temperature (LT) space heating loop proportion. The high temperature space heating 

loop proportion (HT, radiators) is calculated as follows: HT + LT = 100 %. The following design 
temperatures are set by default: 

Space-heating loop Tsupply Treturn 

LT (wall or underfloor heating) 35 °C 27 ℃ 

HT (radiators) 45 ℃ 30 ℃ 

Note: systems whose heat pumps are directly connected to the space heating loop can only be 
operated with LT heating, as the HP can generally not achieve any higher temperatures. 

2. The total resulting parameters: specific heating load and specific annual heat delivery are displayed 
below. 

3. (heat) requirement:define how the heating energy requirement is calculated: either 

• as heating load (the annual heating requirement is then calculated from this), 
• as annual heating requirement (the heating load is then calculated from this) or 
• as monthly heating output. 

Enter the corresponding values. 

4. Define the heated useable area, the indoor temperature and the heating limit temperature. 

In the annual simulation, the relevant heating requirement is calculated from these design data, the 
respective outside temperature and the irradiation. 

A warning is displayed in the event of undersupply. 
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10 Domestic hot water 
Symbol DHW 

 
The heating energy requirement for domestic hot water is an essential parameter for the design of the 
heat pump. 

è How to proceed: 

Circulation 
The DHW supply can be operated with   or without  circulation. 

 Circulation increases comfort, as the hot water is immediately available even with long pipeways, but 
the circulation losses increase the requirement for hot water. As a result, it impacts the simulation 
results and the financial analysis. 

(Hot water) consumption 
1. Click the   DHW consumption known checkbox if you know the total daily DHW consumption. 

2. Enter the value average daily consumption, i.e. the total daily DHW consumption. 

or 

1. Leave the  DHW consumption known checkbox deactivated and 

2. enter the No. Persons and 

3. give an estimation for the consumption per person and day. From this information, the total water 
requirement is calculated: 

average total daily DHW requirement = number of persons * consumption per person and day in 
liters 

Water Temperatures 
1. Enter the desired target temperature of the DHW. If Ttarget > 45 °C, an auxiliary heater is required. 

2. You can let the program calculate the cold water temperature based on climate data. 

or 
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If you leave the calculate cold water temperature based on climate data checkbox deactivated, you 
must enter 
both cold water temperatures for February and August yourself. 

The difference between cold and hot water crucially affects the simulation results and the financial 
analysis. 

Hot water target temperatures over 50 °C can only be achieved by using a heating element. 

A warning message appears if requirements are not met. 
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11 Heat pump 
Symbol Heat pump 

 
The key characteristic values of the selected heat pump which are used for the simulation are displayed 
here. 

è How to proceed: 

Selection 
1. Click on select to choose a heat pump from the database. 

2. The database is opened. You see a table with heat pumps and options simplifying selection, some of 
which can be found in the context menu (See also: Working with the heat pump database). 

3. Narrow down the number of possible heat pumps: 

• Select a product type, brine/water or air/water, 
• or select a manufacturer or user-created heat pump data records, or 
• limit the selection by searching by product (name) or nominal output. 

4. Select a heat pump by double-clicking or clicking on the heat pump and then the Select button. 

Operating mode 
5. Define the operating mode: 

• monovalent: the heat pump supplies the entire space heating down to the lowest outside 
temperature. A second heat generator is not required. 

• monoenergetic: the heating system does not require a second type of energy. As required, 
electrical auxiliary heating is switched on. 

6. Enter the power of the electrical heating element. 

Control (of heating operation) 
To show parallel, part-parallel or alternative operation, define whether the heating element and heat 
pump are to be taken out of service and the associated temperatures. 

7. Select heating element out of service and enter the associated maximum X °C outside temperature. 



User Manual GeoT*SOL basic  11  Heat pump 

Dr. Valentin EnergieSoftware GmbH page 30 / 50 

8. Select heat pump out of service and enter the associated maximum Y °C outside temperature. 

The following applies: 

• Alternative operation:  X = Y 
• Part-parallel operation:  X > Y 
• Parallel operation:     X > Y, with Y= lower design threshold AND X = heating limit temperature 

Seasonal performance factor acc. to VDI 4650 for brine-water and air-water HPs 
For a comparative calculation of the seasonal performance factor according to VDI 4650, enter the 
following values: 

9. bivalence point 

10. minimum source temperature 

11. temperature difference at the condensor, values between 3 and 10 K are possible. 
This is the maximum temperature range on the drain side.   

In the case of heating operation without buffer tank, this temperature difference corresponds to the 
heating range (temperature difference between supply and return). 

In systems with a tank, a temperature difference between 3 and 10 K can be freely selected. 

The calculated seasonal performance factor (SPF) in accordance with VDI 4650 is displayed. 

11.1 Select Heat Pump 
Page Heat pump > Select 

The GeoT*SOL basic heat pump database has been created using manufacturer information and data 
from the heat pump test center WPZ (http://institute.ntb.ch/ies/waermepumpen-testzentrum-
wpz.html). 

 
You see a table with heat pumps and options simplifying selection, some of which can be found in the 
context menu (right-click on a heat pump row). 

http://institute.ntb.ch/ies/waermepumpen-testzentrum
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Working with the heat pump database 

Search function: 
column-based search 

 
Search for: 

• Manufacturer 

• Product (name) 

• Nominal output (note: alphanumeric search) 

Sort table: 

 
Click on column header 

Context menu 

 
Click on a heat pump with the right mouse button. 

User-created favorites 
list 

 
Click on components, context menu Add to favorites 

Create user-defined heat 
pump: 

 
Context menu Create copy  

View properties: 
Context menu data sheet: 
The following information is found on the data sheet: 

• Product information 

• Test points table 

• Scope of application 
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11.2 Customized Heat Pumps 
Page Heat pump > Select > Context menu > Properties / Create a copy 

The same data sheet pages are opened: 

• in properties: to view 
• in create a copy: to edit. 

è How to enter your own HP or edit your own HP data: 
1. Open the heat pump database with select. 

2. Select an HP (left mouse button or simply click). 

3. Go to the context menu (right mouse button) Create a copy (left mouse button). 
 

 
A copy of this HP data sheet is opened. 

4. Give the new heat pump a name, change the manufacturer and the description as required. 

5. Go to the next tab, test points, and fill out the heating power and the electrical power as in the test 
points table conforming to EN 14511. 

6. Go to the next tab, scope of application, and enter the following for the source and drain sides: 

• Volume flow rates 
• Temperatures* (see below) 

7. Save the new HP by clicking OK. The heat pump database is displayed again. 

8. Filter your own heat pumps from the list by clicking the selection box “Show user-created products 
only”. 

 

è How to pass on the data of user-created heat pumps to a colleague: 
1. Go to the file menu and save the project in which the user-created heat pump was used. 

2. Send your colleague the project file, 
e.g. C:\Users\<user name>\Documents\ValentinEnergieSoftware\GeoT*SOL basic 
1.0\Projects\MyHeatPumps.gtprj 

3. This externally created project can be incorporated into GeoT*SOL via the menu File > Open project. 
The user-created heat pump is included. 
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è How to enter the operating temperatures of the HP: 
1. Enter the number of temperature pairs you want: 4, 5 or 6 pairs. 

2. All temperatures must be entered in °C. 
Start with coldest source temperature / coldest drain temperature pair ( ) 

3. Continue counter-clockwise as in the image above. 

! Please note: the area formed by the temperature pairs may not have a “dent”, it must be 
concave on all sides. The operating range represented by the inner, red line of the lower image 
means that this HP cannot be calculated. 

è Solution: omit this point. 
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12 Heat source 
Symbol Heat source 

 

12.1 Select a heat source 
The heat source (HS) for the heat pump (HP) can be the ground or the air. 

The heat source is exploited using a heat source system (HSS). 

U-pipes and double U-pipes can be calculated. 

You must provide certain information here, depending on the medium: 

• Brine/water heat pumps with a geothermal probe as the heat source system 

In a brine/water heat pump, the heat source system consists of brine (typically water with 25 % 
glycole) which is pumped through pipes with a brine pump, resulting in the brine loop. The pipes 
are placed in bored holes up to 400 m deep as U- or coaxial pipes, and are then known as 
geothermal heat probes . 

• Air/water heat pumps with air as the heat source 

In an air/water heat pump, the heat source system consists of fans which generate the air 
stream for the vaporizer of the heat pump as well as a defrosting device. 

12.2 Sizing of an Air-Water Heat Pump System 
If you have selected a system with an air/water heat pump in the preselection, you must enter, on the 
heat source page, 

• the nominal output of the fan(s) and 
• the volume flow rate, 

if these are not stipulated on the data sheet of the selected heat pump. 

12.3 Designing a geothermal probe 
If you have selected a system with a brine/water heat pump, the page heat source appears with the 
parameters for a geothermal probe. 
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è How to define the parameters of the geothermal probe(s): 
1. The power consumption of the HP on the cold side (also called “cooling capacity”) is taken from the 

data sheet of the selected HP. You can only modify it by selecting a different heat pump under heat 
pump. 

2. Enter the specific extraction power and the maximum drilling depth or modify the default values. 

3. The probe length required is calculated. (See below for calculation details.) 
Whenever you modify the specific extraction power or select a different heat pump, the required 
probe length is recalculated. 

4. Click on the sizing button to distribute the required probe length over the number of boreholes by 
the rule of three. Once the boreholes are correctly sized in line with the specific extraction power as 
specified in VDI 4640, no sizing messages appear. 
If the boreholes are not correctly sized in line with the project data, a warning on over- or 
undersizing appears in the messages field. 

If you modify the maximum drilling depth, the number of boreholes and the depth per hole is 
recalculated. 

An experienced planner may depart from the probe length calculated here. The latitude available can 
be quickly and simply calculated by carrying out several simulations. 

Brine pump 
5. Enter the brine pump’s nominal output. 

If the selected heat pump does not have a removable brine pump with a known nominal output, it is 
imported from the database and cannot be edited here. This nominal output has a decisive impact 
on the simulation result SPF of the heating system part. 

6. Enter the flow rate if the latter cannot be taken over from the heat pump data. 

Construction type of the geothermal probe 
7. The borehole diameter is crucial for the simulation with the help of the geothermal probe model. 150 

mm is a typical standard value. The effect of the borehole diameter can be seen in the results charts 

8. The larger the borehole diameter is, the smaller the borehole resistance and the closer the probe 
supply temperature is to the ground temperature (near the probe). 

9. The smaller the borehole diameter is, the greater the borehole resistance and the less the set 
extraction power can be used. 

10. Select a construction of the geothermal probe: 

• Double U-tubes or 
• Single U-tubes. 

11. Type of filler for filling in directly around the geothermal probe, see VDI guideline 4640. There is: 

• simple grouting 
• thermally improved filler 

12. Enter the undisturbed ground temperature, the effective temperature of the surrounding ground 
TER,inf. This is usually between 10 and 15 ℃. 
This temperature is averaged over the entire probe length and (in the upper ground layers) seasonal 
temperatures. 
It thus refers to the undisturbed ground and not ground cooled by geothermal probes or geothermal 
collectors. The deeper the borehole is, the higher the local and seasonally averaged temperature of 
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the undisturbed ground will be. 
See VDI guideline 4640. 

12.3.1 Calculating the length of the geothermal probe 
The required probe length ltarget in accordance with VDI 4640 is calculated from 

 (1) 

with 

PHP,cold = cooling capacity of the heat pump 

L = specific extraction power [W/m] 

The specific extraction power is calculated from the density, heat capacity and heat conductivity of the 
ground as a model. 

12.3.2 Sizing the total drilling length 
The total drilling length is correctly sized when the length of all boreholes deviate from the required 
probe length by less than one percent. 

Effective for the target length is equation (1) and for the actual length lactual = ndrill holes • tper drill hole (2) 

with 

nboreholes = number of boreholes 

nper borehole = depth per borehole 

For the relative deviation f,                                applies (3) 

Correct sizing exists if                 f < 1 %               (4) 

Undersizing exists if                          (5) 

Oversizing exists if                          (6) 
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12.3.3 Sizing with maximum drilling depth 
In addition to sizing the total drilling length in accordance with equations 1 and 4, the maximum drilling 
depth tmax set by you is also taken into consideration. 

The following applies for the maximum drilling depth tmax: 

Drilling 
depth 

Significance 

400 m 
Up to 400 m is known as near-surface geothermal power, this is consequently also 
the maximum value which can be entered in GeoT*SOL. 

99 m 

In Germany, mining law applies from 100 m drilling depth, requiring additional 
licensing procedures. 

Developers frequently avoid these procedures or want to use the boreholes for 
cooling in summer, with the result that they do not drill deeper. 99 m is therefore 
the standard setting in GeoT*SOL. Deeper drilling is frequently encountered in 
Switzerland. 

< 99 m 

For certain geological formations, the authorities sometimes only approve 
boreholes considerably shorter than 99 m. It may also be the case that, for example, 
the conductivity of the ground is very poor from 80 m and it is therefore not worth 
drilling deeper. 
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13 Tank 
Symbol Tank 

 
Depending on your selected system, here you must enter the volume and insulation thickness of the 
domestic hot water tank or the heating buffer tank. 

Depending on the system selection, this page displays heat pump systems with either 

• DHW tank, 
• combination tank or 
• DHW tank and heating buffer tank.   

Depending on the choice made in system selection, the corresponding tanks are displayed in the tanks 
dialog. 

è How to proceed: 
1. Enter the volume of the tank: 

• DHW tank: should be smaller or equal to the daily requirement of domestic hot water. 
• Combination tank: its size depends on the size of the solar installation. 
• Space-heating buffer tank: should be large enough to account for domestic hot water 

requirements and power cuts. 

2. Enter the insulation thickness of the tank. 
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14 Solar loop 
Symbol Solar loop 

 

è How to configure systems with solar support: 

Collector 
1. Select a collector. 

2. Enter the number of collectors. 

Installation 
3. Enter the orientation of the collector array. 

The azimuth is correspondingly displayed. In the northern hemisphere, the azimuth = 0° = south. 

4. Enter the tilt angle of the collectors.  

Piping 
5. Enter the one-way length of the piping in a building. 

6. Enter the one-way length of the piping in an open space. 
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15 Results 
Symbol Simulation results 

 
Using dynamic simulation by the minute, GeoT*SOL basic calculates the relevant characteristic values of 
the heat pump system over the course of a year. 

The weekly COPs and relevant temperatures are also shown in graphical form on the report. 

è How to proceed: 
1. Go to the Simulation results menu. The simulation runs automatically if you have changed any 

settings. 
The progress bar first shows the presimulation. The presimulation has a duration of 3 days for air-
water heat pumps and 120 days for brine-water heat pumps. 

2. Configure the project report to your requirements. 

3. Click on show report to view and, if desired, print the results (for your customer). 

Seasonal performance factor 
The following applies: SPF = benefit / expenditure 

Seasonal performance factor heat pump, calculated by simulation, with test points in accordance with 
EN 15316-4-2: 

• Benefit is the heat supplied by the HP 
• Expenditure is the total electricity consumption of the HP 

Seasonal performance factor of the generation system: 

SPF generation system brine: 

• Benefit is the total heat supplied by the HP and heating element 
• Expenditure = total electricity consumption of the HP 

                 + heating element energy consumption 

                 + electricity consumption of the probe pump 
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SPF generation system air: 
• Benefit is the total heat supplied by the HP and heating element 
• Expenditure = total electricity consumption of the HP 

                 + heating element energy consumption 

Energy supply (electrical)/year 
- for the heat pump or its compressor 

- for the auxiliary energy (users: pumps, fans) 

Generated energy/year 
- energy produced from the heat pump 

- energy produced from the solar collector loop 

- energy produced from the auxiliary heater 

Useable energy/year 
- heating 

- domestic hot water 

Losses/year 
- Tank 

- Circulation of DHW 

- Solar loop piping in a building 

- Solar loop piping in an open space 

Solar loop 
- Solar fraction, energy from the solar collector, in relation to the total of generated energy. 

- Collector loop efficiency 

- Irradiation onto gross collector area 

- energy produced from the collector 

   

è See also: 
The costs per kWh of thermal energy are shown on the financial analysis page and in the report. 

15.1 Project report 
The project report includes: 

Page 1:  you can edit all cover sheet information on the project data page or via the Options > User data 
menu. 

Page 2: system layout; results of the annual simulation: energy requirements, as applicable solar 
fraction and seasonal performance factors, power consumption, heat losses 

Page 3: settings: climate, domestic hot water, heating; system components: heat pump 

Page 4: system components (ff): geothermal probe, collector, DHW tank; financial analysis 

Page 5: financial analysis (ff); seasonal performance factors in accordance with VDI 4560 for comparison 
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Page 6: charts: HP performance factor and energy delivered over the year, brine temperatures upstream 
and downstream of the HP, ground temperature 

è How to proceed: 
The project report can be 

• Configure the project report to your requirements via Options > Project report. 
• saved, 
• saved in a range of file formats (.ll, .pdf, .tiff, .txt, .emf, .jpg, .xps) or 
• printed. 

The view menu enables navigation over the pages. 

 

15.2 Financial analysis 

 

è The profitability and heating price* of your heat pump system is calculated here. 
1. Enter the following general parameters: 

• Lifetime of the heat pump system  
• Imputed interest rate***  
• Expected average annual price increase  

2. For the financing, enter the following: 

• Investments, 
• subsidies and 
• loan parameters 

The total is calculated. 

3. Enter other costs: 

• Maintenance costs, 
• the electricity price and 
• other operating costs as a whole 

From these and the heat pump and the auxiliary energy users, the following is calculated: 

• the heating price*, 
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• the electricity costs** of the heat pump, 
• the electricity costs of the auxiliary heater and 
• the electricity costs for auxiliary energy. 

4. Click on Open report to print a brief financial analysis presentation of the heat pump system (for 
your customer). 

*Heating price 
Using the heating price, the heat pump can be compared with other heating systems (e.g. with a gas- or 
oil-fired boiler) to assist the property owner when making an investment decision. 

For the heating price, the investment less the subsidy and the operating and maintenance costs via 
annuities (lifetime, simple interest) are apportioned to the heat yield. 

** Electricity costs 
The electricity costs relate to the entire lifetime and are discounted, they are thus actual cash values in 
relation to the time of investment. 

*** Imputed interest rate and cash flows 
The actual cash flows are higher. The actual cash value must therefore be the basis for the imputed 
interest (e.g. 10 %). Then, the electricity costs for the entire lifetime can be paid with this sum and the 
interest income from the bank. If you’re interested in the actual cash flows, the imputed interest can be 
set to zero. 
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16 Glossary 
Auxiliary energy 
Electrical energy used by heating, cooling, ventilation and/or domestic hot water installations to support 
energy conversion to meet energy requirements 
NOTE 1: this includes the energy for fans, pumps, electronics etc. The electric energy supplied to the 
ventilation system for air transport and heat recovery is not considered auxiliary energy but the 
ventilation energy requirement. 
NOTE 2: in EN ISO 9488 [15], the energy requirement for pumps and valves is called “parasitic energy”. 
NOTE 3: within the present standard, the drive energy for electrically-operated heat pumps within the 
system threshold of the COP in accordance with EN 14511 and for an electrical auxiliary heater is not 
termed parasitic energy but merely as the additional supply of electrical energy not covered by the COP. 
DIN EN 15316-4-2:2008-09 

Auxiliary heater 
Additional heater used for generating heat when the heat pump’s power is insufficient. Ensures that the 
target temperature is reached. The energy supplied by the auxiliary heater must be reduced to a 
minimum, e.g. less than 5 % of the total energy generated by the heat pump, if the auxiliary heater’s 
energy source is not renewable. 
DIN  EN 15450:2007-12 

Bivalence point 
Lowest standard outside air temperature at which the heat pump output power and the heat requirement 
(heating load) of the building are equal. 

NOTE A second heat generator is used at lower outside air temperatures in order to meet part or all of the 
building’s heat requirement. 

Bivalence temperature 
With outdoor temperatures lower than the bivalence point, an additional heating takes over partly or at 
all. The heat pump covers the heat demand only for temperatures above the bivalence points.  
Therefore, the bivalence point is used for system design. Usually, it is about -5°C. 
There is no such temperature in monovalent operation. 

Brine 
Heat transfer medium with a freezing point lower than that of water. DIN EN 14511-1:2008-02. e.g. 
ethylene glycol and water (liquid to -13 °C) 

Coefficient of performance 
Ratio of useable heat flow produced under specific operating conditions in relation to the electrical 
energy used for driving the compressor and the auxiliary drives in accordance with DIN EN 14511/DIN EN 
255-3. 
VDI 4650-1 draft 2008-09 

Cold water temperature 
Domestic hot water setting, dependent on season; DIN EN 15450:2007-12 

Combination tank 
Tank used both for hot water supply for domestic use and indoor heating. 
DIN EN 12977-3:2008-11 

Compressor 
Key power-consuming part of a heat pump 
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Depth-dependent temperature increase 
Typically 3 K per 100 m 

Design temperature 
Temperature stipulated by the prevailing climatic zone in accordance with DIN EN 12831 supplementary 
sheet 1 table 1a. DIN EN 12831 

Drilling depth 
DIN EN 15450:2007-12 

Domestic hot water requirement 
DIN EN 15450:2007-12 

Double U-tube 
Property of the geothermal probe 

EN 15316-4-2 
Heating systems in buildings – method for calculation of system energy requirements and system 
efficiencies – part 4-2: heat generation for indoor heating, heat pump systems. 

Extraction factor, annual specific 
In addition to the specific extraction power, must be considered for longer periods and should be 
between 50 and 70 kWh/(m2 ∙ a) for geothermal heat collectors and between 100 and 150 kWh/(m ∙ a) for 
geothermal heat probes. 
VDI 4640-2:2001-09 

Extraction power [W / m2] 
i.e. heat pump vaporization power. 
VDI 4640-2:2001-09 

Ground temperature, undisturbed 
DIN EN 15450:2007-12 

Geothermal energy, near-surface 
to 400 m depth 

Heating energy requirement 
Calculated amount of energy which must be supplied to a building’s heating system in order to be able 
to meet heating requirements. 
DIN V 4108-6:2003-06 

Heating limit temperature 
Base temperature, outside air temperature, above which a building at a set indoor air temperature need 
no longer be heated. 
DIN V 4108-6:2003-06 

Heating load ФHL [kW] 
DIN EN 15450:2007-12, VDI 4640-2:2001-09 

Heating requirement 
Computed heat input via a heating system required to maintain a specific average indoor temperature in 
a building or a zone within a building. This value is also known as the net heating energy requirement. 
DIN V 4108-6:2003-06 

Heat power 
In accordance with DIN EN 12828:2003, 4.2.2: ΦSU = fHL ⋅Φ HL + fDHW ⋅Φ DHW + fAS ⋅Φ AS The heat 
power of the heat pump can be maintained at a low value by avoiding additional heating loads caused by 
periodic heating (e.g. by preventing nighttime reductions). 
DIN EN 15450:2007-12 



User Manual GeoT*SOL basic  16  Glossary 

Dr. Valentin EnergieSoftware GmbH page 46 / 50 

Heat pump 
Assembly or assemblies enclosed in a housing for supplying heat and ready for connection. The device 
contains an electrically-operated cooling unit for the heat supply. It can also be equipped for cooling, 
circulating, purifying and humidifying the air. Cooling operation is effected by reversing the cooling 
loop. 
DIN EN 14511-1:2008-02 

Heat pump systems, small 
up to 30 kW. 
DIN EN 15450:2007-12 

Heat source 
Amounts of heat with temperatures above the indoor temperature which are supplied to the building 
zone or arise within the building zone. Not included are regulated heat inputs supplied via the system 
(heating, ventilation) to maintain the indoor temperature. 
DIN V 18599-1:2005-07 

Heat transfer medium 
Any medium (water, air, ..) used for heat transport without a change of state EXAMPLE ⎯ cooled liquid 
circulating in the vaporizer; ⎯ cooling agent circulating in the condensor; medium circulating in the heat 
exchanger for heat recovery. 
DIN EN 14511-1:2008-02 

HP 
Heat pump. 
VDI 4650-1 draft 2008-09 

Inside air temperature 
Air temperature within the building. 
DIN EN 12831:2003-08 

Loss, system~ thermal 
Thermal loss of a heating, cooling, DHW heating, humidifying, dehumidifying, ventilation or lighting 
installation or other application, which does not contribute to the useable power of the system 
NOTE Thermal energy which is immediately recovered in the subsystem is not considered as thermal loss 
of the system but as heat recovery and is addressed directly in the relevant system standard. 
DIN EN 15316-4-2:2008-09 

Low temperature disconnection -> see Heat pump > Control 
Temperature at which operation of the heat pump is interrupted and the entire heat requirement is met 
by auxiliary heating. 
DIN EN 15316-4-2:2008-09 

Monoenergetic operation 
The heat distribution system is supplied by two heat generators which both use the same type of energy 
(e.g. electricity). From an outside temperature (e.g. -5 °C) up to one which at which the heat pump can 
meet the heating load on its own, the auxiliary heating is switched on as required at low outside 
temperatures. The two heat generators work in parallel. The operating mode is suitable for all heating 
systems up to the maximum supply temperature of the heat pump. 

Monovalent operation 
Operating mode in which the heat pump is configured in such a way that it alone meets the entire heat 
requirement of the heating system. 
NOTE: the heat pump output power is here the same as the standard heating load calculated in 
accordance with EN 12831. 
DIN EN 15450:2007-12 
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Nominal output 
Capacity measured under standard rated conditions. 

Outside temperature 
Outside air temperature used for calculation based on meteorological measurements and analyses. 
DIN V 18599-1:2005-07 

Presimulation 
The presimulation generates the settled state following the initial operation phase. The length varies on 
the basis of the differing inertia of the heat sources: 

Brine-water HPs: presimulation = 120 days. 

Air-water HPs: presimulation = 3 days 

Primary pump 
Pump incorporated in the cycle which contains the generator and the hydraulic decoupling, e.g. in the 
form of a heat tank in parallel construction or a hydraulic distributor. 
DIN EN 15316-4-2:2008-09 

Solar fraction (α) 
Dimensionless energy component which a heat pump contributes to meeting the annual space heating 
and hot water heating requirement of a building or area. 
VDI 4650-1 draft 2008-09 

Seasonal performance factor SPF 
Ratio of the total energy amount QHP supplied from the heat pump to the distribution system for indoor 
heating and/or to other connected systems (e.g. domestic hot water). 

DIN EN 15450:2007-12; DIN EN 15316-4-2:2008-09 

Seasonal performance factor ß 
Ratio of useable heat produced annually in relation to the electrical energy used for driving the 
compressor and the auxiliary drives. 
VDI 4650-1 draft 2008-09 

SPF 
Not standardized but common term for seasonal performance factor (ß) 

Standard outside temperature 
Outside air temperature used for calculating standard heat loss. 
DIN EN 12831:2003-08 

Standard indoor temperature 
Operative room temperature in the center of the heated room (between 0.6 m and 1.6 m height), used for 
calculating standard heat losses. 
DIN EN 12831:2003-08 

System technology losses 
Losses (heat loss, cold loss) in the technical process steps between the useable energy requirement and 
the final energy requirement, i.e. during transfer, distribution, storage and generation. Losses in the 
system technology, as long as they occur in the conditioned space, count as heat sources or heat sinks. 
DIN V 18599-1:2005-07 

Useable energy requirement for domestic hot water 
Computed energy requirement resulting from the building zone being supplied with the amount of 
domestic water at the necessary supply temperature defined in the use profile. 
DIN V 18599-1:2005-07 
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Useable heating requirement 
Useable heating requirement = space heating requirement 
Computed heating requirement necessary to maintain the defined thermal indoor conditions within a 
building zone during the heating period 
DIN V 18599-1:2005-07 
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